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Abstract:

The objective of this project is to design a camera mount that can continuously track an object by its specific
colour. Using image processing, it is capable of continually centering the trained colour of the image in the
frame. Using servo motors, the camera mount is able to track the colour with two dimensions of motion,
vertical tilt and horizontal pan. The camera captures the live video and compares each pixel within a threshold
value we set in using the HSV (Hue, Saturation, Value) image format for continuously tracking the object
when light intensity changes due to varying lighting conditions. The design is implemented on a Altera
Terasic DE2 development board. The coloured-object tracking camera has been successfully implemented,
meeting most of our functional requirements.
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FUNCTIONAL REQUIREMENTS

The project is to implement a coloured-object tracking camera, which will use a camera to view an area,
recognize the designated colour to be tracked, and adjust the camera’s orientation to keep that particular
coloured object within the frame of the camera.

The functionality of this project involves interfacing the camera as the input for the DE2 board, and servo;,
which the camera is mounted to, as the output for repositioning. A VGA monitor for the output of the camera
image would be used for demonstration and debugging purposes.

Detecting Set Colour in Image

The camera will take composite video signals from camera and send it to the TV decoder chip built into the
Altera DE2 board through the video-in port. The frame data will then go through a series of colour space
conversions, and finally to HSV format signals used for threshold comparison. From there, we will compare
each pixel's colour to the target colour predefined in the system.

Position of Coloured Object in Image

After threshold comparison, the system records the first and last pixel which pass the comparison algorithm as
each pixel goes into the image processor. At the end of the frame, the center of the moving object can be
calculated by averaging x and y coordinate of first and last pixels.

Horizontal and Vertical Tracking

After computing the position of the center of the object from the image processor, the system will calculate
the displacement between the center of the frame and the centre of the target. It then converts the
displacement further into the moving angles of the servo motors. The servo motor will take the instructions
(of the proper angle) and drive the camera to face the centre of the target.

Monitor Implementation

The system outputs the image which is received from the camera to a monitor using the VGA cable. The
monitor can illustrate the functionality of the tracking system. As an extension, it can output the threshold
image, showing the pixel which passes the threshold comparison as white, and everything else black. This will
be used for debugging, testing, and demonstrating purposes.

Changing the Colour Being Tracked

During operation, users can change the colour that is being tracked by flipping a configure switch. To achieve
this, the system will clear the old colour being tracked and change it to the new one by capturing the colour
from center of frame.

Movement lock

Horizontal and vertical direction lock are implemented into the tracking system and this functionality is
controlled by switches. When user locks one direction, then the tracking camera is only able to track the
object along with the other direction.



DESIGN AND DESCRIPTION OF OPERATION
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This is a block diagram of our design. The external video and other peripherals are marked as blue, and
the hardware components of FPGA are marked as yellow, and the red blocks indicate the process we

did in the software layer.

Hardware Layer and Data flow

NTSC input signals from the camera will go to the FPGA board through composite video cable. The stream of
signals is firstly passed into the analog-to-digital converter chip to normalize data to digital signals. Then, it
will be decoded and converted into YCrCb (4:2:2) colour space. The chroma resampler will convert the aspect
ratio of YCrCb (4:4:4) with the original frame resolution. After that, it will be further converted into the 24-bit
RGB format signals. The above processes mentioned is predefined by Video IP cores in Altera University
Program. After scaler, one stream of 16bit 320 x 240 RGB format signals is written directly into the video
buffer as the output for display, while the other stream of signals is passed into image processor. RGB format
is converted into HSV to have threshold comparison with predefined threshold value and the register will
record the position of first and last pixels which pass the comparison. When it reaches the last pixel of the
frame, the center of the tracking object can be calculated by averaging the distance of x and y directions. The
center coordinate is retrieved by software layer to calculate the displacement between the center of the frame



and the center of the object and convert it to the number of degrees that servo motor need to move in order to

re-center the object. The horizontal and vertical movement instructions are then sent to another hardware
component (called a servo motor controller in separate tasks). The servo motor controller is a pulse width
modulator, which sends proper pulse widths to GPIO for driving the servo motors to track the target. Also,
switches are implemented to define the threshold value of the image processor, enable the threshold image on
the display, and lock either horizontal or vertical direction of the tracking system. The current state of the
tracking system and some brief instructions about how to set the colour will be shown on the LCD screen.

RGB to HSV Conversion

The reason why we choose HSV instead of RGB to do the threshold comparison is because HSV separates the
colour value from the intensity of lighting. Therefore, the lighting condition will not affect the HSV format
pixels seriously. The main conversion algorithm is implemented as a part of image processor FPGA
component. The conversion is processed according to the formula:

S = MAX(R,G,B) — MIN(R,G,B)

V = MAX (R,G,B)

=0,V =0

= E=8x60°, (if MAX = R)

= BB x60° + 120, (if MAX = G)

= ¥x60° + 240, (if MAX = B)

We process one pixel at a time, used immediately to do the threshold comparison which is the second part of

TR

image processor.
Threshold Comparison

In this part, we will take the H, S, V values converted from RGB format pixels to compare a threshold range
predefined in the system. This range is calculated by a threshold value defined by users, plus and minus a
reasonable range. This range is determined according to many tests because we need to set a considerable
range to avoid both of over-shrinking the relevant pixels and having too much noise.

(H ipreshota — Hrange < H < Hyypopora + Hrange) 1 (Spreshota = Srange < S < Sppreshora + Srange) [

(Vthreshold o Vrange <V < Vthreshold + Vrange)

Orientation

While the processor goes through each pixel in a frame, it will record the first pixel which passes the threshold
comparison, and keeps updating the upcoming passed pixels as the last pixels. After processing the whole
frame of pixels, the center of the object will be located by taking average of x and y of both the first pixel and
the last pixel. And the output of the coordinate is stored in the register and can be retrieved.

X — x[irst + xlast — y[ir.vt +ylast
centre 2 y centre 2



Displacement Calculation

This displacement can be calculated by subtracting the center of the frame by center of the moving object
which is obtained from the previous step. The relative displacement then is calculated by subtracting the
current position to the previous position. Then, we need to convert the oriented displacement to the number of
degrees which the servo motor needs to rotate and send it to Servo Motor Controller. Horizontal and vertical
direction are using different tasks, with a negligible delay, to ensure the rotation is synchronized.

Pulse Didth Modulator

The Servo Motor Controller generates proper pulse widths to drive the servo motors by reading the data
calculated from the software layer. For our servo motors, we have 1.5ms pulse width to generate a neutral
position signal, running on a 50Mhz clock rate, and we need to count 75000 to generate that instruction. As
well, the boundaries can also be calculated using clock rate to multiply the desired pulse width. With one
degree of rotation matching a certain number of counts, the servo motor is able to accomplish the tracking by
pointing to the center of object.

Bill of Materials
Qty Part Specification Supplier Cost(CAD)
Altera Terasic DE2 Development Board | (See Data Sheet Site) University (USD $284)
including USB cable and 9V DC 1.3A
power brick $357.71!
Datasheet:

https://www.altera.com/support/training/
university/de2.html

ADS-120 Home Indoor Security Camera e  Viewing Angle: 53° FutureShop $39.99
e  White Balance: Automatic

Datasheet: e  Effective Pixels: NTSC 640 x 480

http://www.swann.com/downloads/produ e  Weight: 0.2 kg

ct/2017ADS-120 M120CAMO041012E

web.pdf

Hitec HS-422 Servo Motor e  Operating voltage: 4.8V to 6V University $12.18?
e  Operating speed: 0.21 to 0.16 sec/60°

Datasheet: e  Stall torque: 3.3 kg-cm to 4.1 kg-em

http://www.robotshop.com/media/files/p

df/hs422-31422s.pdf

Hitec HS-635HB Servo Motor e  Operating Voltage: 4.8V to 6V Universty $35.25°
e  Operating speed: 0.18 to 0.15 sec/60°

Datasheet: e Torque: 5.0 kg-em to 6.0 kg-ecm

http://hitecred.com/products/servos/sport-

servos/analog-sport-servos/hs-635hb-kar

bonite-high-torque-servo/product

Mount Fabrication Cost Estimate cost of re-purposing an old mount: ECE Machine $178.00

5.5 machine shop hours — Shop

$25 x first 4 hours + $50 x 1.5 hours = $175
$175 + $3 for new faceplate = $178



https://www.altera.com/support/training/university/de2.html
https://www.altera.com/support/training/university/de2.html
http://www.swann.com/downloads/product/2017ADS-120_M120CAM041012E_web.pdf
http://www.swann.com/downloads/product/2017ADS-120_M120CAM041012E_web.pdf
http://www.swann.com/downloads/product/2017ADS-120_M120CAM041012E_web.pdf
http://www.robotshop.com/media/files/pdf/hs422-31422s.pdf
http://www.robotshop.com/media/files/pdf/hs422-31422s.pdf
http://hitecrcd.com/products/servos/sport-servos/analog-sport-servos/hs-635hb-karbonite-high-torque-servo/product
http://hitecrcd.com/products/servos/sport-servos/analog-sport-servos/hs-635hb-karbonite-high-torque-servo/product
http://hitecrcd.com/products/servos/sport-servos/analog-sport-servos/hs-635hb-karbonite-high-torque-servo/product

1 Ribbon Cable University $15.00

1 5V Power Supply University N/A
* Required but not included in total

1 Mini-breadboard Team Member $5.00

2 Alligator Clips University $1.50

2 Power Supply Cables University $20.00

Total Cost: | $ 664.63

US price converted using exchange rate of 1 US : 1.26 CAD as of April 13, 2015 at 3:16 pm

. Price collected from http://www.robotshop.com/ca/en/hitec-hs422-servo-motor.html; used regular price
3. US price collected from http://www.hobbyhorse.com/hitec_hs635hb.shtml converted using exchange rate of 1 US : 1.26 CAD as of April

13,2015 at 3:16 pm

o =

REUSABLE DESIGN UNITS

1. Altera University Program Video IP cores [1]

Used to convert the NTSC input video signals into the 320 x 240 16-bit RGB formal colour space stored in the
video buffer (SRAM) and then output the signals to the monitor.

2. “Tutorial of displaying pixels on VGA monitor”[2]

This tutorial explain the basic procedure on how to set up the video IP core from Altera University Program
and demonstrate how to using build-in functions to write a pixel intot the video buffer.

And the video buffer set-up functions are based on this source code.

BACKGROUND READING

1. “Development of a Generic RGB to HSV Hardware” [3]
Notes: This paper overviews the conversion from RGB to HSV. It also describes hardware to convert RGB

to HSV.

2. “Tracking coloured objects in OpenCV” [4]
Notes: This OpenCV project inspired our method for using a threshold for. We won’t be using OpenCV in
this project. This project is where the idea of using HSV for the threshold came from.
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DATA SHEET

Defined FPGA component:

Image processor
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Image_Processor 0

lock avalon_streaming

avalon_streaming_source
_ 0_ cey

reset

avalon

valon_streaming_sink

avalon_streaming

avalon
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Image_Processor

Pin Name Note Connection Type

clock System clock Internal connection
reset Reset signal Internal connection
sl Store coordinate of x and y Internal connection

avalon_streaming_sink

Receive incoming RGB signals

Internal connection

s2...s5 Temporary register for debugging and testing Internal connection
h thresh Store H threshold value and threshold range Internal connection
s_thresh Store S threshold value and threshold range Internal connection
v_thresh Store V threshold value and threshold range Internal connection
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p_00 Store colour information on Internal connection
coordinate (Xcenter-5, Ycenter-5)

p_01 Store colour information on Internal connection
coordinate (Xcenter, Ycenter-5)

p_02 Store colour information on Internal connection
coordinate (Xcenter+5, Ycenter-5)

p_10 Store colour information on Internal connection
coordinate (Xcenter-5, Ycenter)

p 11 Store colour information on Internal connection
coordinate (Xcenter, Ycenter)

p_12 Store colour information on Internal connection
coordinate (Xcenter+5, Ycenter)

p_20 Store colour information on Internal connection
coordinate (Xcenter-5, Ycenter+5)

p_ 21 Store colour information on Internal connection
coordinate (Xcenter, Ycenter+5)

p 22 Store colour information on Internal connection

coordinate (Xcenter+5, Ycenter+5)

conduit_end

Check value of threshold switch

On-board connection

Servo motor controller

(0]

ervo

conduit

avalon

clock

reset

conduit

awalan

Serva

Servo

Pin Name Note Connection Type
clock system clock Internal connection
reset reset signal Internal connection

conduit_end 0

send pulse width to GPIO

On-board connection

sO

store movement instruction

Internal connection




FPGA Board to Servo Motor
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FPGA Pin # Connection Note

PIN D25 GPIO_0[0] => White[Signal] (Horizontal) connect GPIO pin to signal line of
the horizontal servo motor

PIN_ K25 GPIO_1[0] => White[Signal] (Vertical) connect GPIO pin to single line of
the vertical servo moter

N/A GND => Black [Vss] Connect the ground.

Top-Level Pin Assignment

System control

FPGA Pin # Connection
PIN_N2 clk 0 =>CLOCK 50
PIN_G26 reset n =>KEY(0)

Video Out signal
FPGA Pin # Connection
PIN_BS vga_controller_external interface CLK => VGA CLK
PIN_D6 vga controller external interface BLANK =>VGA_BLANK
PIN A7 vga controller external interface HS => VGA_HS
PIN DS vga_controller external interface VS =>VGA_VS
PIN_B7 vga_controller _external interface SYNC =>VGA SYNC
Multiple Pins vga controller_external interface R => VGA_R[0-9]
Multiple Pins vga_controller_external interface G => VGA_G[0-9]
Multiple Pins vga_controller_external interface B => VGA_BJ[0-9]

Video In signal

FPGA Pin #

Connection

Multiple pins

tv_decoder_controller external interface DATA =>TD DATA[0-7]

PIN D5 tv_decoder_controller_external_interface HS =>TD_HS
PIN_K9 tv_decoder_controller_external_interface VS =>TD_VS
PIN_C16 tv_decoder_controller external interface CLK27 =>TD_CLK27
PIN_C4 tv_decoder_controller external interface RESET =>TD RESET
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PIN A6 tv_decoder_controller external interface 12C SCLK =>12C_SCLK

PIN_B6 tv_decoder_controller external interface I2C_SDAT =>12C_SDAT
SDRAM controller signal

FPGA Pin # Connection

Multiple pins

sdram_0_wire_addr=> DRAM_ADDRJ[0-11]

PIN AE2 & sdram 0 wire ba =>DRAM BA
PIN_AE3

PIN_AB3 sdram 0 wire cas_n=>DRAM CAS N
PIN_AA6 sdram_0_wire cke => DRAM_CKE
PIN_AC3 sdram_0 wire ¢s n=>DRAM CS N

Multiple pins

sdram_0_wire_dq=>DRAM_DQ[0-15]

PIN Y2 & sdram_0_wire_dgqm => DQM
PIN AD2
PIN_AB4 sdram 0 wire ras n=>DRAM RAS N
PIN_AD3 sdram 0 wire we n=>DRAM WE N
SRAM controller signal
FPGA Pin # Connection
Multiple pins sram_0_external interface DQ => SRAM_DQ[0-15]

Multiple pins

sram_0_external_interface. ADDR => SRAM_ADDR][0-17]

PIN_AE9 sram_0_external interface LB N=>SRAM LB N

PIN_AF9 sram_0_external interface UB_ N =>SRAM UB N

PIN_ACI11 sram_0 external interface CE N=>SRAM CE N

PIN_ADI0 sram_0 external interface OE N =>SRAM OE N

PIN_AEI10 sram_0_external _interface WE N =>SRAM WE N
LCD signal

FPGA Pin # Connection

Multiple pins

character lcd 0 external interface DATA =>LCD _DATA

PIN L4

character lcd 0 external interface ON =>LCD_ON
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PIN K2 character lcd 0 external interface BLON =>LCD_BLON
PIN K3 character lcd 0 external interface EN =>LCD_EN

PIN K1 character lcd 0 external interface RS =>LCD_RS
PIN_K4 character lcd 0 external interface RW =>LCD RW

Switch signal:

FPGA Pin # Connection Note

PIN_N25 config_switch_external export =>SW(0) Set SW(0) as configuration
switch

PIN V2 h lock switch external export =>SW(17) Set SW(17) as x-lock switch

PIN VI v_lock switch_external export => SW(16) Set SW(16) as y-lock switch

PIN_N26 image processor 0 conduit_end export => SW(1) Set SW(1) as threshold image
switch

PIN_P25 square_switch_external _connection_export => SW(2) Set SW(2) as indication switch

Non-volatile signal

FPGA Pin #

Connection

PIN W17

tristate_conduit_bridge 0 out generic_tristate_controller 0 tcm_read n _out=>FL OE N

Multiple pins

tristate_conduit_bridge 0 out generic_tristate controller 0 tcm_data out => FL DQ[0-7]

Multiple pins tristate_conduit_bridge 0 _out generic_tristate controller 0 tcm_address_out => FL_ADDR[0-21]

PIN_AA17 tristate_conduit_bridge 0 out generic_tristate controller 0 tcm write n out=>FL WE N

PIN V17 tristate_conduit_bridge 0 out generic_tristate_controller 0 tcm chipselect n out=>FL CE N
Power Supply:

High Speed Continuous Rotation Servo Motor :6V DC
Swann Security Camera: 12V DC
Altera DE2 Board: 9V AC/DC
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SOFTWARE DESIGN

Threshold Switch > Image Processor
Set threshold filter

Retrieve system states

Retrieve center coordinate
Update threshold value

. . . Determine states
Configuration Switch LCD Screen

Write message to

Send horizontal displacement Send vertical displacement

Hardware

Control harizontal displacement Control vertical displacement

FPGA component

X Lock switch Y Lock Switch _

As per the figure shown above, we define 4 tasks in software layer.

When users flip the configure switch to set the colour they want to track, we need to write the input
register of image processor through the software layer. The center pixel of the frame will be recorded
directly, immediately after the value of switch goes to one, and the threshold value inside the image
processor will be changed. Therefore, the incoming pixel will be filtered according to the new
threshold value. To achieve this, we define a task (Image processor task) used to monitor the current
state of the configuration switch to check whether the value is high (setting the color) or low (tracking
the object). When the system is in the set-up state, the servos will stop working and go to its natural
position. A 5x5 green square will be drawn at the center of the screen to indicate users to put the object
inside the square. Initial tracking function will be used to read the center pixel of the frame. The
reading HSV value is retrieved from a register used to specifically record the center pixel. And it will
also based on the one calculated by image processor FPGA component to ensure the consistency of
colour information. After that, the H, S and V values of that pixel are directly written to the register
used to define the threshold value. And it will keep changing the threshold value until the value of
configuration switch goes low. When the system enters the tracking state, servos will resume working
and locate pixels that pass the threshold comparison. Because this process is done by hardware and the
register value always stays until it is updated by writing instruction, there is no extra synchronization
needed additionally. The system will detect the change of threshold value every clock cycle.

We define two tasks (Horizontal Movement and Vertical Movement) to handle the horizontal
movement and vertical movement independently, with a negligible delay to ensure x and y rotation are
processed approximately simultaneously. X and Y lock switches can control the movement of servos.
If the value of lock switches are high, then the servos of that direction will stop moving.

Also we used another task (LCD screen display) to write some information on the LCD screen. When
the user wants to set colour, the LCD will display some brief instruction about how to set the colour.
And when the camera tracks some object, the LCD screen indicates the current states tracking the
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system - such as showing states of the X and Y direction locks.

Test plan
Software:
Our original plan is to have all image process in the software layer. That includes all unit tests
of the image process functions:
Test 1: memory layout pattern of video buffer
Intention: use Altera video buffer function to figure out how pixels arranges on the screen.
alt up pixel buffer dma draw(pixel buf dev, colour, x, y);
Result: it stores pixels in inside video buffer as a pattern of x-y coordinate like:
(0,0) (0,1) (0,2)
(1,0) (1,1) (1,2)
(2,0) 2,1) 2.2)
Test 2: threshold comparison unit test
Intention: we test a number of pixels with defined threshold range to check if the function is
implemented properly.
Result: The function successfully filter the pixels that fail the comparison test.
Test 3: Output 2D pass-fail array unit test
Intention: processing the whole frame data and store the output result, a pass-fail value to a 2D
array.
Result: The function can output an 2D array with correct size.
Test 4: Positioning unit test
Intention: this will test the functionality of algorithm used to locate the center of the object.
Result: It correctly outputs the center coordinate.
Test 5: Servo controller test
Intention: ensure the function can convert the displacement to angle and write it to servo motor
controller register.
Result: The angle conversion algorithm is working properly and it can store the correct value
into the register.
Test 6: Communication between switch to FPGA hardware component
Intention: When user flips switches, software layer is responsible to send the information to
image processor and also give feedback to LCD screen by retrieving the current states of image
processor.
Unfortunately, we failed to do the image process in the software layer (Test 1-4), the speed of
locating the center of moving target is 18 seconds per each frame. This is due to the algorithm
implemented for positioning. Therefore, we defined a FPGA component to process image with the

same rate as it transmitting pixels to the monitor.
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Hardware:

Image processor: We tested the image processor in three stages, firstly we tested if it can correctly
convert form RGB colour space to HSV format. To do that, we send instructions to convert a certain
RGB pixel to HSV, and then output the value to check if the values are identical to what we expect.
Secondly, image processor needs to filter the pixels properly. We can test that by storing the result to a
temporary register inside image processor, and use software layer to read the register to verify the
correctness of the output. Lastly, image processor will locate the center of the object after the last pixel
of the frame is processed. We can directly check if the algorithm is properly implemented by retrieving
the coordinate, and then draw it on the monitor.

Servo motor controller: We use an oscillator to test if the Servo Motor Controller is generating the
given pulse width.

SAFETY

The main external devices used in this project are two servo motors. Therefore there are no restricted or
dangerous materials used.

Since this project simply rotates in place, horizontally and vertically, the only safety issue with the
motion would be the swinging energy of the mount. For the horizontal rotation servo motor, the
rotational speed is reported at 0.18sec/60° or 1.08 sec/360°.

Converting to rads/sec:

_ rads 360° rads
o =2n 360° X 1.08 sec 5.8178 sec

Using the rotational kinetic energy equation:
KE, ational = %I W

Where: 1 — Moment of inertia

® — Angular velocity

We get:
1 = 8.1471 x 1074kg-m2 (see appendix : Polar Moment of Inertia Calculations)
KE,ppiiona = 31 W? = 5(8.1471 x 1074kg'm2)-(5.8178 %)2 = 0.013788 J
Since the value for this rotation energy is quite small (magnitude of -2), the rotational energy of the
mount would cause negligible harm.

ENVIRONMENTAL IMPACT

There are hazardous substances used in our project and therefore is RoHS compliant.

SUSTAINABILITY

Calculating CO2 emissions

k
COy. gmission = (2.81% (0.45739 kgco,) = 0.989%

Calculating Servo Power Consumption
Operating Voltage, Vo, = 5V
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Running Current, 1,, = 0.264

Running Servo Power, P ..., yumping = Vop Lop = (5V)-(0.264) = 1.3W

*Note: It is intuitive to simply power down system when not running, therefore, the system is never
idle

Calculating DE2 Power Consumption

Operating Voltage, Vo, = 9.1V

Operating Current, 1,, = 0.5554

Operating Power, P g o, = Vop Iop = (9.1V)(0.5554) = 5.0505W
Calculating Camera Power Consumption

Operating Voltage, V., = 12.08V

Operating Current, 1,, = 0.0554

Operating Power, P cyperg op = Vop lop = (12.087)-(0.0554) = 0.6644W

Total Power Consumption (CO, Emission and Cost)

Total Running Power, P = P servo, running T P pE2, 0p T P Camera, op = 1-.3W +5.0505W +0.6644W
P pumning = 7.0149W

Assume 3 hours of continuous, recreational use a day, everyday:

CO, Emissions = T.0149W x &l x 3 x 365 2552 0.989 55 — 7.602% of CO, emission

Energy Cost = T.0149W x {HHll x 3 x 36525922 x 8 7 = $0.67/year

year

Running

The CO, emissions for this project is estimated at 7.602 kg/year and the cost to run is $0.67/year.
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QUICK START MANUAL

Hardware Configuration

1. Download the G4 Coloured Object Tracking Camera.qar file from the web page.
Open Quartus and select Project > Restore Archived Project, and select the
G4 Coloured Object Tracking Camera.qar in your download directory and click OK.
Double Click Compile Design to run the program
When it completes compile, double click Program Device
5. Set up the connection in hardware:
a. connect power adapter from Altera DE2 Board to power source
connect USB cable from Alter DE2 Board to Computer
connect composite video cable to Video-In port on DE2 Board
connect VGA cable from a monitor to VGA-port on DE2 Board.
connect horizontal servo signal line to GPIO 0[0] pin.
connect vertical servo signal lien to GPIO_1[0] pin.
connect power adapter to from camera to power source
connect power supply to both of servos and change the voltage to 5V.
6. Chck Auto Detect on the left side bar.
7. Select niosll_micror lab 1.sof and click Start.

> »

sm e ac o

Now, the monitor should be able to show the image from the camera.
Software configuration

Open Eclipse from the Quartus by selecting Tools -> Nios II software Build Tools for Eclipse
Choose your Workspace directory to the software file inside the project.

Click File -> New -> Nios II Application and BSP from Template

Choose the video_sys.sopcinfo in SOPC Information File Name field.

Name your project

Select Templates as Hello MicroC/OS-I1

Click Finish

Right Click your project in Project Explorer window, and select Build Project
Delete hello ucosii.c file from the project.

10 Copy image processor_software.c into the project.

11. Right click on project and select Run As -> Nios II Hardware

00N AU AW

User Guide

Configuration Switch: used to change the state of setting color or tracking color

Threshold Image Switch: used to show pass fail pixels on the screen, all the passed pixels will be
shown as white pixels and others will be shown as black.

Indicator Switch: used to show the center coordinate of the object on the screen by a green square
while tracking.

X-Lock Switch: used to stop horizontal rotation of camera

Y-Lock Switch: used to stop vertical rotation of camera



“X-ock  YJock
Switch-Switch
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How to set the colour:

1.

(O8]

Flip configuration switch and place the object we wish to track at the green square showing on
the screen.

(Optional) Flip Threshold Image Switch to see if the object is marked as white pixel on the
screen.

Flip configuration switch again and the camera should start to track the object.

For changing colour, re-do the procedure 1-3.
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FUTURE WORK

Custom Settings
Focusing on artistic side of videography, implementing multiple settings for tracking style would

improve filming variety as well as increase the demographic of targeted users. Examples of this would
being able to change the rotational speeds of the servos, improving smoothness, and perhaps viewing
experience. Another custom setting would be to preset tracking limits, making the target leave the
camera’s view at predefined angles which can add an artistic approach to filming.

Minimize Form Factor

In our camera’s current form factor, the desired intention to be utilized for action sports, is highly
improbable. The next step to this design would be to scale down the size. Multiple things can be
implemented to realize this objective. One would be custom circuit boards, with a more optimized chip
layout (instead of using the development board, design a board with only the components needed).
Also scale down the size of the physical mount, making the cradle and cradle support much smaller and
more compact. Consolidating the power source for all the components will also decrease the size. Since
video output is necessary for colour configuration, either adding a small display to the mount itself or
have the video streamed from the mount to your phone using local wifi of bluetooth.

Modernize

A hindrance for future development and success for this project is that we implemented our design
using NTSC composite video. The issue with this is that NTSC is an older technology and most
cameras don’t use this technology. For our intents and purposes, we wish to have the source of the
video to be modular, as in, the goal is compatibility with any camera the user wishes. By modernizing
this, either with USB or HDMI video in, we can use any modern camera, such as GoPros or DSLRs.

Improve Tracking Algorithms
Since we were under time constraint for the development of this project, we decided to use simple

algorithms for calculating the centre of the object and finding our threshold ranges. To improve our
algorithm for calculating the centre of the object, instead of using the simple method of averaging the
coordinates of the first and last pixel, we would like to keep track of the longest continuous line of
horizontal and vertical pixels that pass. Also, filtering out noise by ignoring lone pixels or lone
anomalies. Implementing algorithms to detect colour patterns and instead of having simply scalar
ranges for the threshold values (like + 5 for hue), we would design algorithms that dynamically shift
ranges according to white balance shifts from the camera, lighting changes, and camera quality.



HARDWARE DOCUMENTATION
Defined FPGA component:
Image Processor : The main functionalities of the image processor include converting RGB to HSV,

filter the pixels that pass the threshold comparison test and find the center coordinate of the tracking
object and stored it into a register.

Image_Processor 0
lock avalon_streaming_source.
felock avalon_

valon_streaming_sink

lon_streaming
g2

3
4
5

thresh

thresh

v _thresh

ange

00

ondut_enc!

Image_Processor

Servo Motor Controller: Used to generate given pulse width modulation and send it to GPIO pins

Servo




SOFTWARE DOCUMENTATION:

main.c
**************************************************************************/
* Description: *
* This file shows the software layer of our design, The functionalities*
* of this file includes calculating the pulse width of servos, controlling
* movement of the servo and communicate between image processor and user *
* interface *
**************************************************************************/

#include <stdio.h>

#include <system.h>

#include <stdlib.h>

#include <time.h>

#include "includes.h"

#include "altera_up avalon video pixel buffer dma.h"

#include "io.h"

#include "altera_up_avalon character lcd.h"

/* Definition of Colour */
#define GREEN 0xF800

/* Definition of Image processor Parameter */
#define H MASK 0x00000007FFF
#define S_MASK 0x000007F8000
#define V_MASK 0x0007F800000

#define H_OFFSET 0
#define S_OFFSET 15
#define V_OFFSET 23

#define DEFAULT H _RANGE 10
#define DEFAULT S_RANGE 20
#define DEFAULT V_RANGE 80

#define HSV_ RANGE_REGISTER OFFSET 24

#define H_REGISTER_MASK 0x000001ff
#define S_REGISTER_MASK 0x000000ff
#define V_REGISTER_MASK 0x000000ff

#define X_ MASK 0x3ff
#define Y MASK 0xFfC00
#define X_OFFSET 0
#define Y _OFFSET 10

/* Definition of Screen */
#define CENTER X 160
#define CENTER Y 120
#define MARGIN 5

/* Definition of Servo Moter Parameter™®/
#define MAX PULSE WIDTH 125000
#define MIN_PULSE WIDTH 75000
#define PULSE WIDTH PER DEGREE 425
#define PIXEL PER DEGREE 26.5

/* Definition of Task Stacks */

#define TASK STACKSIZE 2048
OS_STK taskl stk[TASK STACKSIZE];
OS_STK task2 stk[TASK STACKSIZE];
OS STK task3 stk[TASK STACKSIZE];
OS_STK task4 stk[TASK STACKSIZE];

/* Define Global Variable*/
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alt up pixel buffer dma dev * pixel buf dev;
alt up character lcd dev * character lcd dev;

float degree x,degree y;
int z=20;
int flip =0;

/* Definition of Task Priorities */
#define TASK1 PRIORITY 1
#define TASK2 PRIORITY 2
#define TASK3 PRIORITY 3
#define TASK4 PRIORITY 4

/*
* Servo control function for the HS-422
* Input: The number of degrees of horizontal rotation needed
* Output:
* 1 : If the servo angle is at max rotation (? ms pulse width)
-1 : If the servo angle is at min rotation (? ms pulse width)
* 0 : Servo doesn't reach limits
*/
int horizontal servo(float number of degrees){

/1 (-) left, (+) right

// +- 950 to move 1 degree

// Max is ~ 250000, min is ~ 60000

int pulse_width = 0,err = 0;

int old =IORD_32DIRECT(SERVO_0 BASE, 0);

*

pulse_width = old + number of degrees*PULSE WIDTH PER DEGREE;

if (pulse_width > MAX PULSE WIDTH){
pulse width = MAX PULSE WIDTH;
err=1;

}

else if(pulse_width < MIN PULSE WIDTH){
pulse_width = MIN_PULSE_WIDTH;
err=-1;

old =IORD_32DIRECT(SERVO_0_BASE, 0);
IOWR_32DIRECT(SERVO_0 BASE, 0, pulse_width);
old =IORD_32DIRECT(SERVO_0_BASE, 0);

return err;

}

/*
* Servo control function for the HS-635HB
* Input: The number of degrees of vertical rotation needed

* Qutput:

* 1 : If the servo angle is at max rotation (? ms pulse width)
* -1 : If the servo angle is at min rotation (? ms pulse width)
* 0 : Servo doesn't reach limits

*/

int vertical_servo(float number_of degrees){
/I (=) up, (+) down
/I +- 950 to move 1 degree
// Max is ~ 125000, min is ~ 25000
int pulse_width =0, err =0, old = 0;
old =1IORD_32DIRECT(SERVO_1_BASE, 0);

pulse_width = old - number_of degrees*PULSE_WIDTH_PER_DEGREE;

if (pulse_width > MAX PULSE WIDTH){
pulse_width = MAX_PULSE WIDTH;
err=1;

i

else if(pulse_width < MIN_PULSE_WIDTH){
pulse width = MIN PULSE WIDTH;
err=-1;

}

old =TIORD_32DIRECT(SERVO 1 BASE, 0);

IOWR_32DIRECT(SERVO 1 BASE, 0, pulse_width);
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old =IORD_32DIRECT(SERVO_1_BASE, 0);
return err;

}

/*
* Initial_tracking function will be used to replace the value of the register which stores
* threshold value in the image processor by the value read from the center of the frame.
*/
void inital_tracking(){
inth 11,v_11,s 11, center pixel,
h_reg, s_reg, v_reg;

// Read the center pixel from the image processor
center_pixel = IORD_32DIRECT(IMAGE_PROCESSOR_0_P11_BASE,0);

/I Get H, S, V value of the center pxiel
v_11=(hsv_11&V_MASK)>>V_OFFSET;
s 11 =(hsv_11&S MASK)>>S OFFSET;
h 11=(hsv_11&H MASK)>>H OFFSET;

// Generate a 32bit number which contains the threshould range and threshold value of each colour fields
h reg = ((DEFAULT H RANGE<<HSV_RANGE REGISTER_OFFSET) | (h_11&H REGISTER MASK));
s reg = ((DEFAULT_S_RANGE<<HSV_RANGE_REGISTER_OFFSET) | (s_11&S_REGISTER_MASK));
v_reg = ((DEFAULT_V_RANGE<<HSV_RANGE REGISTER_OFFSET) | (v_11&V_REGISTER_MASK));

// Updating the value to the register.
IOWR_32DIRECT(IMAGE PROCESSOR 0 H THRESH BASE,0,h reg);
IOWR_32DIRECT(IMAGE_PROCESSOR_0 S THRESH_BASE,0,s reg);
IOWR_32DIRECT(IMAGE_PROCESSOR_0 V_THRESH_BASE,0,v_reg);

//Draw a green suqare at the center of the frame for indication
alt up pixel buffer dma draw rectangle(pixel buf dev, CENTER X-MARGIN, CENTER Y-MARGIN,
CENTER_X+MARGIN,CENTER_Y+MARGIN, GREEN, 0);

}

/*
* This function is used to clear the LCD screen by erase the content of all the cursor postions
*/

void clear_lcd(alt up character lcd dev *lcd){
intx=0;
inty=0;
alt_up character lcd set cursor_pos(lcd,0,0);
for(y = 0; y <2; y+H){
for(x = 0; x < 16; x++){
alt_up character lcd erase pos(lcd,x,y);

}
}
alt_up_character lcd set _cursor_pos(lcd,0,0);
}
/*
* This function is used to write a string onto the LCD screen
*/

void write_lcd _msg(alt up character lcd dev *lcd, char* msgl, char®* msg2){
clear_lcd(led);
alt up character lcd set cursor pos(lcd,0,0);
alt_up character lcd_string(led, msgl);
alt_up_character lcd_set _cursor_pos(lcd,0,1);
alt up character lcd_string(led, msg2);

}

/*Clears the led*/

void servo_init(){
IORD 32DIRECT(SERVO 1 BASE, 0);
IOWR_32DIRECT(SERVO_1 BASE, 0, 100000);
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IORD_32DIRECT(SERVO 1 BASE, 0);
IORD_32DIRECT(SERVO_0_BASE, 0);
IOWR_32DIRECT(SERVO_0_BASE, 0, 75000);
IORD_32DIRECT(SERVO 0 BASE, 0);

}

/*

*This task is used to showing the message about the current states of the tracking system when
*the configuration switch goes low.

*/

void task4(void* pdata){

while(1){

char* msg;
char* msg2;
if ((IORD_8DIRECT(CONFIG_SWITCH_BASE,0)){
if IORD_8DIRECT(H_LOCK_SWITCH_BASE,0)){
msg ="X LOCK is ON";
i

else{

}

if JORD_8DIRECT(V_LOCK_SWITCH_BASE,0)){
msg2 ="Y_ LOCK is ON";

msg ="X LOCK is OFF";

}
else{

msg2 ="Y LOCK is OFF";
}
write_lcd_msg(character lcd dev,msg,msg2);
OSTimeDIyHMSM(0, 0, 0, 250);

}
}
}
/*
* This task is used to control the horizontal servo movement.
*/
void task2(void* pdata)
{
while(1){
if('lORD_8DIRECT(H_LOCK_SWITCH BASE,0) && !I0RD_8DIRECT(CONFIG SWITCH_BASE,0)){
horizontal servo(degree x);
}
OSTimeDlyHMSM(0, 0, 0, z);
}
}
/*
* This task is used to control the vertical servo movement.
*/
void task3(void* pdata)
{
while(1){
if('IORD_8DIRECT(V_LOCK SWITCH_BASE,0) && !TORD 8DIRECT(CONFIG _SWITCH_BASE,0)){
vertical servo(degree y);
}
OSTimeDlyHMSM(0, 0, 0, z);
}
}
/*

* This task is used to retrieve and process the center of object in order to send movement instruction
* to servo for tracking. It also handles two different states of the tracking system, setting the initial colour and tracking the colour.
*/



void task1(void* pdata)

{

intr=0,g=0,b=0;

intxy=0,h=0,s=0,v=0,x=0,y =0, thr=0;

int counter = 0,row=0,row_index = 0;

int temp1,temp2,temp3,temp4;

int max,min;

int xmin,xmax,ymin,ymax,relative_x,relative y;

character lcd dev =alt up character lcd open_dev("/dev/character led 0");

/I open pixel buffer device

pixel_buf dev =alt_up_pixel_buffer dma_open_dev("/dev/Pixel Buffer DMA");
if (pixel buf dev==NULL)

// if pixel buffer cannot be found, type error message.
printf("Error: could not open pixel buffer device \n");
} else

{

}

/I Make sure the pixel buffer device has the primary buffer address
if (pixel_buf dev->buffer start address !=0)
{

printf("Opened pixel buffer device \n");

alt up pixel buffer dma change back buffer address(pixel buf dev, 0)
alt_up pixel buffer dma swap_ buffers(pixel buf dev);
}
/I swap buffer to the back buffer (start address of SDRAM for as frame buffer)
alt_up pixel buffer dma swap_ buffers(pixel buf dev);

// Showing welcome message when the program is initialized properly
alt_up_character lcd_init(character lcd_dev);
char* welcome_string = "Hello, welcome!";
alt_up_character lcd_string(character lcd_dev,welcome_string);
alt up character lcd cursor off(character led dev);
OSTimeDIlyHMSM(0, 0, 1, 0);

while(1){

iflIORD_S8DIRECT(CONFIG_SWITCH_BASE,0)){
flip=1;
servo_init();
/I showing a brief instruction about setting colour
char* msg = "Place object";
char* msg2 ="in green square";
write_lcd_msg(character_lcd_dev, msg, msg2);
// it will keep updating the threshold value in the register until the value
// of configuration switch goes low.

while(IORD_8DIRECT(CONFIG_SWITCH_BASE,0)){
inital_tracking();
}
// servo process will be suspended in setting state.
servo_init();

}

// If the state is tracking, then it will retrieve the center coordinate from register

// in the image processor
xy =1ORD_32DIRECT(IMAGE PROCESSOR 0 S1 BASE,0);
x = (xy&X_ MASK)>>X OFFSET;
y = (xy&Y_MASK)>>Y OFFSET;

relative_x =x - CENTER_X;
relative y =y - CENTER Y;

//' IF the movement is not siginificant, then the servo can ignore it
if ((relative_x < 10) && (relative x > -10)){
relative x =0,

s
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if ((relative_y < 10) && (relative_y > -10)){
relative_y = 0;

}

degree x =relative x/PIXEL PER_DEGREE;
degree_y = relative y/PIXEL PER DEGREE;

OSTimeDlyHMSM(O0, 0, 0, 5);
//'8 fps

/* The main function creates two task and starts multi-tasking */
int main(void)
{
servo_init();
alt_ up character lcd init(character lcd_dev);
OSTaskCreateExt(task1,
NULL,
(void *)&taskl stk[TASK STACKSIZE-1],
TASK1 PRIORITY,
TASK1_PRIORITY,
task1_stk,
TASK_STACKSIZE,
NULL,
0);

OSTaskCreateExt(task?2,
NULL,
(void *)&task2_stk[TASK_STACKSIZE-1],
TASK2 PRIORITY,
TASK2 PRIORITY,
task2 stk,
TASK STACKSIZE,
NULL,
0);

OSTaskCreateExt(task3,
NULL,
(void *)&task3 stk TASK STACKSIZE-1],
TASK3 PRIORITY,
TASK3 PRIORITY,
task3_stk,
TASK STACKSIZE,
NULL,
0);
OSTaskCreateExt(task4,
NULL,
(void *)&task4 stk TASK STACKSIZE-1],
TASK4 PRIORITY,
TASK4 PRIORITY,
task4_stk,
TASK STACKSIZE,
NULL,
0);

OSStart();
return 0;

}

28



MOUNT DESIGN
Figure 1: CAMERA MOUNT
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Figure 3: CRADLE SUPPORT
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POLAR MOMENT OF INERTIA CALCULATIONS FOR CAMERA MOUNT
Polar moment of inertia:
t=J-a
where: T — Torque [N - m]
J — Polar Moment of Inertia [kg - m?]
o — Angular Acceleration [”;’—2”’
Parallel axis theorem:
J=J+m-d
where: J — Polar Moment of Inertia about axis of rotation [kg - m?]
J — Polar Moment of Inertia about centre axis [kg - m?]
m— Mass [kg]
d— Distance between centre axis and axis of rotation [m]
c - cradle
cs - cradle support

Here we assume material is aluminium (p = 2660%) .

Part 1: Polar Moment of Inertia for Vertical Rotation: (Figure 2)

Side:

M, ge = V- p = (0.051m) - (0.023m)- (0.002m) - 2660-%) = 6.24 x 10 kg

Jode = Tom(h* +w?) =15(6.24 x 10 kg)[(0.023m)* +(0.051m)’] = 1.6277 x 10 *kg - m?
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Parallel axis theorem:
d = |%(0.023m)—(0.01m)] = 0.0015m

I side=Jsigetm-d = (1.6277 x 10 kg - m?) + (6.24 % 10 kg)(0.0015m)’
Jo sige = 1.6417x 10 %kg - m?
Bottom:

M porom = V- p = (0.155m) - (0.051m) - (0.004m) - (2660-%) = 8.41 x 10 kg
Tioom = T3m(h>+w?) =-5(8.41 x 10 °kg)[(0.004m)* + (0.051m)*] = 1.8343 x 10 kg - m?

Parallel axis theorem:

d =10.023m — 0.01m — 0.002m| = 0.011m

e vottom = Jporom T - & = (1.8343 10 kg - m?) + (8.41 x 10 *kg)(0.011m)’
I bortom = 2-852x10 kg - m?

Camera:

mcamera = 0'2kg

Jeamera = Tm(h* +w?) =15(0.2kg)[(0.012m)” +(0.037m)’] = 2.5217 x 10 kg - m?

Parallel axis theorem:
d =10.013m — 0.01m — 28 = 0.0155m

e camera = Jeameratm-d® = (2.5217x 10 kg~ m?) + (0.2kg)(0.0155m)’
T camera = 7-3267 %10 kg - m?
Total:

Jvert, total — 2- Jc, side + Jc, bottom +J

c, camera

= 2-(1.6417 x 10 ®kg - m?) + (2.852 x 10 kg - m?) +(7.3267 x 10 kg - m?)

J = 1.0507 x 10 *kg - m?

vert, total

Calculating Angular Acceleration
For Vertical rotation, T = 3.3kg-cm x 9.815%5 < 1

(torque @ 4.8V accordin§ to data sheet)

= 0.32373 N-m

—m__
100 cm

Jvert, o = 1:0507 % 10 kg - m?
=1 — _032373Nm _ 3rad
«=7 1.0507x10 *kg-m? 3.0811 x 10755

Since our angular acceleration is very large, the cradle of the mount should move instantly with no lag
caused by a lack of torque, i.e. the torque provided by the servo for the vertical rotation is sufficient for
this.

Part 2: Polar Moment of Inertia for Horizontal Rotation:
Cradle: (Figure 2)

Side:

M. gige = 60.24% 10" kg (from above)

Jode = Tom(h* +w?) =15(6.24 x 10 kg)[(0.002m)* + (0.051m)*] = 1.3546 x 10 *kg - m?




Parallel axis theorem:
d = [(0.155m)—(0.001m) | = 0.0765m
o side =Jsige Tm- & = (13546 x 10 kg - m?) + (6.24 x 10 kg)(0.0765m)’

J, e = 3.7873x10 kg - m?

¢, side

Bottom:

M poriom = S-41% 10 *kg (from above)

T porom = Tam(h*+w?) =75(8.41 x 10 *kg)[(0.155m)* + (0.051m)’] = 1.8660 x 10 kg - m?

Camera:
Mceamera = Ozkg

Jeamera = Tsm(h>+w?) =15(0.2kg)[(0.012m)" +(0.037m)’] = 2.5217 x 10 kg - m?

Cradle Support: (Figure 3)

Side:

Mg sige =V P = (0.105m) - (0.051m) - (0.002m) - 2660-%) = 2.8489 x 10 kg

Jge = Bm(h>+w?) =5(2.8489 x 10 *kg)[(0.002m)” +(0.051m)’] = 6.1844 x 10 *kg - m?

Parallel axis theorem:
d = }(0.165m)—(0.001m) | = 0.0815m

s, side = Jsige - d = (6.1844x 10 kg - m?) + (2.8489 x 10 *kg)(0.0815m)’
Jos side = 1.9542% 10 kg - m?
Bottom:

My porom =V *P = (0.165m) - (0.051m) - (0.002m) - (2660-%) = 4.4768 x 10 *kg
J = Lm(h* +w?) =5(4.4768 x 10 *kg)[(0.165m)> + (0.051m)’] = 1.1127 x 10 *kg - m?

cs, bottom

HS-422 Servo:
Mservo = 0.0455 kg

Jservo = Tm(h* +w?) =5(0.0455kg)[(0.0366m) + (0.0198m)*] = 6.5657 x 10 kg - m?

Parallel axis theorem:

d = [1(0.0165m)+(0.002m) +1(0.0198m) | = 0.02015m
o somo = Jsemotm-d* = (6.5657 x 10 kg - m2) + (0.0455kg)(0.02015m)’
J = 2.5040 x 10 kg - m?

c, servo

Total:
Jhorz, total ~ 2 Jc, side + Jc, bottom + Jc, camera +2- Jcs, side + Jcs, bottom + Jc, servo

= 2-(3.7873 x 10 kg - m2) +(1.8660 x 10 *kg - m?)+(2.5217 x 10 kg - m?)
+2-(1.9542 x 10 *kg - m?) + (1.1127 x 10 kg - m2) +(2.5040 x 10 kg - m?)

hors. torar = 81471 x 10 *kg - m?
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Calculating Angular Acceleration
For Horizontal rotation, T = Skg-cm x 9.814 X 1755~ = 0.4905 N -m
(torque @ 4.8V according to data sheet)
Jhors. toral = 81471 x 10 kg - m?
o =% = —LBBNm_ — 0] x 1074

Since our angular acceleration is very large, the entire mount should move instantly horizontally with
no lag caused by a lack of torque, i.e. the torque provided by the servo for the horizontal rotation is
sufficient for this.



